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Using Oracle Cloud to Power Your Application Development Lifecycle 

In this lab you’ll create a new project with an initial repository in Oracle Developer Cloud 
Service (ODevCS) Web Dashboard. You will then import a project from archive into 
Oracle Enterprise Pack for Eclipse (OEPE) IDE. This is a simple Java EE SOAP web 
service application that will be the basis for exploring ODevCS both within the web 
dashboard and through integration within Oracle Enterprise Pack for Eclipse. 

In the first part of the lab, you’ll log in to your ODevCS web instance and start with 
creating a project and selecting a project withan “Initial Repository” option. After creating 
the project you’ll explore the features of ODevCS and then proceed to create a couple 
tasks that you will activate and complete within the IDE (OEPE). As part of this lab you’ll 
build this project using Hudson Continuous Integration Tooling within ODevCS and 
automatically deploy the application to Oracle Java Cloud Service - SaaS (OJCS-SX). 
You will then validate the jsf web page. 

Why ODevCS? In recent years the world of application development has adopted new 
methodologies that aim to improve the quality and speed in which applications are being 
delivered. The introduction of innovative development approaches such as test driven 
development and agile development gave rise to a set of new techniques and tools that 
enable those methodologies. Tools such as automatic build utilities combined with 
continuous integration platforms, as well as enhanced collaborative tools such as wikis 
and code review utilities aim to simplify the adoption of these new methodologies. 
However, for many IT shops setting up these environments and maintaining them was 
difficult and cost prohibitive, resulting in many organizations sticking to the old way of 
building applications. Now Oracle is aiming to change this by introducing a new simpler 
way to adopt modern DevOps and tools with a cloud based offering known as ODevCS.  

Requirements: 

For this lab, all the required software is provided. If you do not finish this lab you can run 
through it at your convenience from home. All you need to is the following: 

1. Create an Oracle Java Cloud Service SaaS Extension account here. You will be 
provided with a 30 day free access account along with an entitlement for Oracle 
Developer Cloud Service and Oracle Database Cloud Service. 

2. Download and install Oracle Enterprise Pack for Eclipse. 
3. Download and install Java SDK 8. Grab the latest update.  



Step 1: Create a project with an initial repository 

1. Begin by logging in to the ODevCS web dashboard. 

 https://cloud.oracle.com 

2. Select Data Center “US Commercial 2” and proceed to sign in to the Cloud 
services. 

 

3. Provide the “User Name”, “Password”, and “Identity Domain” that was provided 
by the lab instructor. Note: There may be a prompt to change the password the 
first time logging in.  

 

4. Once authentication is complete, a Dashboard will be displayed showing all 
active platform services. Select the “Developer (Developer)” service link. 

 



5. Select the “Open Service Console” button. This opens the ODevCS Projects 
view. 

 

6. Select “New Project” button. 

 

  



7. Give the project a Name such as “OOW Contacts Soap Service” and Description 
similar to the following: “OOW Contacts SOAP Service created with an Initial 
Repository”. The Privacy setting will be set to “Private” by default. Select the 
“Next” button. 

 

8. Select the “Initial Repository” option followed by the “Next” button. 

 

  



8. Select the preferred “Wiki Markup”. Select the “Create Project” button. 

 

9. Project services are now being provisioned and can take up to a minute. Notice 
the feature indicators turning green as each of the features are being provisioned 
followed by the web dashboard being displayed. 

 

  



10. Explore the various Features of ODevCS. The “Home” tab for instance provides 
details about the newly created project including the location of the Git source 
code repositories as well as the Maven repository. Notice new activities within 
the project as they occur. In addition, team management is available here as well 
as the ability review statistics on the active project. 

 

11. The “Code” tab provides details such as the working repository and branch as 
well as the ability to view files in the repository along with commits. Branches can 
be created here along with tags and there is also the functionality to perform diffs 
on code. 

 

12. The “Merge Requests” tab is where code reviews are created and assigned to 
reviewers to approve, reject or iterate over followed by merging a branch back 
into the master. All open reviews are visible here as well as all reviews 
historically including the ability to filter on reviews. 
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13. The “Issues” tab is where new tasks are created and assigned to team members. 
Searches can be performed for specific tasks with advanced search capabilities 
or via the standard search that’s provided. 

 

14. The “Build” tab is where Hudson build jobs are created, configured, builds are 
invoked, view build status, view build history, etc… Until a project is created and 
a build job is created/configured, this tab will provide limited details. 

 

16. The “Deploy” tab allows for new deployment configurations to be created on a 
project. After creating a “New Configuration”, a deployment can be started, a 
deployment can be deleted, an application can be redeployed, a deployment 
configuration can be edited and/or deleted. 

 

17. The “Wiki” tab allows for the creation of new Wiki pages for collaboration with 
members of the development team. This is a good starting point to start creating 
use cases and other design documents for an application.  

 



18. Create a new Wiki page. Select the “New Page” button now and provide some 
descriptive text for the project as seen in this image. Select the “Save” button 
once complete. 

 

19. The “Administration” tab is where management functionality is provided for 
various aspects of the project including properties, usage metrics, issues, source 
code, merge requests, webhooks and atom/rss feeds.  

 

  



Step 2: Open Oracle Enterprise Pack for Eclipse (OEPE) IDE and connect to the 
ODevCS instance. In this step a project will be imported into the IDE (OEPE) from 
an archive. 

1. Open the IDE (OEPE). Look for the OEPE IDE icon on your desktop.  

 

2. Within the IDE (OEPE) close the “Welcome” page and switch to the “Java EE” 
perspective by selecting the open perspective icon on the top right of the IDE to 
the left of “Resource”. 

 

3. Select the “OK” button. 

 

4. In the bottom left of the IDE (OEPE) there will be a cloud view, “Oracle Cloud”, 
where a connection to ODevCS instance can be established. Select the 
“Connect” link. 

 

  



5. Enter the credentials supplied by the lab instructor and select the “Finish” button. 

 

6. Expand the “Developer” tree to see projects that are available. 

 

7. Right click on the “OOW Contacts SOAP Service” or the project name used 
earlier if different and select “Activate”.  

 

  



8. Expand the “Code” item in the tree and right click on the Git repository. It will be 
the one named “[oow-contacts-soap-service.git]” and right click to select 
“Activate” to clone the project to the local Git repository. 

 

9. A dialogue will appear indicating that the cloning process is running. Let it 
complete. 

 

10. Import the contacts.zip archive into the IDE OEPE. Select the “File” menu item 
followed by “Import”. 

 

  



11. Expand the “General” tree and select “Existing Projects into Workspace”. Select 
“Next”. 

 

12. Select the “Select archive file:” radio item. 

 

  



13. Select the “Browse” button and select the “contacts.zip” archive. This archive 
should be located in “C:\oepe12.1.3.8\workspace” directory. Select the “Open” 
button. 

 

14. Select the “Finish” button to import the archive into the IDE (OEPE). 

 

  



15. The contacts project is now successfully imported into the IDE (OEPE) and 
should resemble the following image as seen in the “Project Explorer” view 
window. 

 

16. Select the “contacts” project in the “Project Explorer” view window of the IDE 
(OEPE) and drag-n-drop it on the “Git repo [oow-contacts-soap-service.git]” in 
the “Oracle Cloud” view window. This synchronizes the contacts project with 
ODevCS. Essentially it pushes the project content into the Git repository in 
ODevCS as well as versions it in the local Git repository. Go with the defaults 
here and select the “Finish” button.  

 

17. Wait for process to complete. 

 

  



18. Notice in the “Project Explorer” view window that the “contacts” project now 
indicates that it is versioned. 

 

19. Go to the “Home” tab in the ODevCS Web Dashboard browser and examine the 
activity feed. Notice the activity for versioning the “contacts” project from the IDE 
(OEPE). Also notice that a build has been completed successfully. The build was 
already configured in Maven pom.xml within the contacts project in the IDE 
(OEPE). 

 

 

  



Step 3: Create a new issue within the browser (ODevCS Web Dashboard) and 
resolve the issue within the IDE (OEPE). 

1. Select the “Issues” tab within the ODevCS Web Dashboard browser. 

 

2. Select the “New Issues” button to create a new issue. Enter details similar to 
these provided here. For “Owner”, assign the issue to user provided by the lab 
instructor. Select the “Create Issue” button once complete. 

 

  



3. The first task has now been created and can be edited with the ability to post 
comments as desired. 

 

4. Now go to the “Oracle Cloud” view in the lower left of the IDE (OEPE) and right 
click on “Isues” and select “Activate”. Right click on “Open” tasks in the tree and 
select “Activate” and expand it to see the task that was just created in the 
ODevCS Web Dashboard browser. 

 

5. There are various ways to work with issues so now within the IDE (OEPE) as 
opposed to working within the “Oracle Cloud” view in the bottom left corner of the 
IDE (OEPE), let’s take a look at the “Task List” in the upper right corner of the 
IDE (OEPE) beneath “Resources”. Expand the Open tree table if needed. 

 

  



6. Right click on the “Create web methods create, update, and delete.” and select 
“Activate” to activate the task. 

 

7. Create a branch named “work”. This will become the active branch to make code 
changes. Later, a code review will be created followed by a merge of the “work” 
branch back into the “master”. In the “Oracle Cloud” view in the lower left of the 
IDE (OEPE) expand “Code | oow-contacts-soap-service.git | Branches”. Right 
click on “Local” and select “Switch To | New Branch”. 

 

8. The “Create a new branch” wizard will appear. Provide a “Branch name” of 
“work” and select the “Configure upstream for push and pull”. Click the “Finish” 
button when complete. 

 

  



9. The new branch “work” now becomes the working branch as can be seen from 
the “Project Explorer” in the IDE (OEPE). 

 

10. Open the “ContactsService.java” object within the “Project Explorer” in the IDE 
(OEPE) and add the web methods create, update, and delete. The 
“ContactsService.java” object is located within the tree structure “src | main | java 
| services”. Copy the following code and paste it into the “ContactsService.java” 
object and be sure to save the application. 

	   @WebMethod	  
	   public	  void	  createContact()	  {	  
	   	   return;	  
	   }	  
	  
	   @WebMethod	  
	   public	  void	  updateContact()	  {	  
	   	   return;	  
	   }	  
	  
	   @WebMethod	  
	   public	  void	  deleteContact()	  {	  
	   	   return;	  
	   }	  
	  

 

  



11. The code should now look like the following: 

 

12. Now that the methods have been added as requested within the task that was 
created, commit the changes to the local Git repository and then push the 
changes to the remote repository. This can be done in one step within the IDE 
(OEPE). Right select on the “ContactsService.java” object within the “Project 
Explorer” and select “Team | Commit…”. Provide a “Commit Message” similar to 
“Created web methods for create, update, and delete.” Select the “Commit and 
Push” button to commit and push the changes to the remote repository. 

 

  



13. A “Push to branch on remote” wizard will be invoked. Go with the defaults as 
indicated in this image and select the “Next” button to continue. 

 

14. In the next step of the wizard go with the defaults and select the “Finish” button to 
complete the source push to the remote repository in the cloud.  

 

15. A dialogue will be provided with the results of the commit / push operation. Select 
the “OK” button to exit the notification. 

 

  



16. Take a look at the “Oracle Cloud” view in the IDE (OEPE) and notice that the 
“work” branch is in fact the active branch and that it has been created in the 
remote repository in the cloud. 

 

17. Now that the changes have been committed and pushed to the Git repository, the 
task needs to be updated. Right click on the task in the “Task List” within the IDE 
(OEPE) and select “Open”. This opens the task within the IDE (OEPE) so that it 
can be updated as resolved. Add a new comment such as “Method for create, 
update, and delete has been added in the ContactsService.java object. This task 
is now complete.” Select the radio button “Resolve as” and select “FIXED” from 
the list-of-values. Select the “Submit” button to update this task. 

 



18. Now that this task has been completed, take a look at the “Task List” tab in the 
(OEPE) and notice that this task has been flagged as complete. 

 

19. Go back to the ODevCS Web Dashboard browser. Select the “Home” tab to see 
the new activity stream with the updates for the previous task. 

 

20. Select the “Code” Tab, “work” branch and then the “Commits” button. Select the 
button to the left of the “Code” button. 

 

21. Select the “Diff Preferences” icon to get a before and after (side-by-side) view of 
the code changes in the “ContactsService.java” object. 

 

  



22. The diff of the “ContactsService.java” object will look something like the following 
image. 

 

23. Create one more issue to update a jsp page. This time create the issue from 
within the IDE (OEPE). Within the “Oracle Cloud” view, in the lower left corner of 
the IDE (OEPE), Right click on “Issues” and select “New Issue”. 

 

  



24. Provide the following details for the new issue: 

Name: “Update index.jsp with new message” or something similar 

Due Date: Set it to the current date 

Estimated Time: 1 

Description: Enter some descriptive text 

Assignee: Assign this task to yourself 

Once complete, select the “Submit” button. Notice the new issue has been 
created by looking at the “Task List” in the upper right corner of the IDE (OEPE).  

 

  



25. As before, go back to the ODevCS Web Dashboard browser and select the 
“Home” tab to see the activity and that the new issue has synchronized with 
ODevCS. 

 

26. Activate the task in the IDE (OEPE) by Right clicking on the task in the “Task 
List” view and selecting “Activate”. 

 

27. Now open index.jsp and add some updated message to the page. index.jsp can 
be found in the “Project Explorer” within the IDE (OEPE) in the following location 
“src | main | webapp”. 

 

28. The index.jsp page should resemble the following: 

 

  



29. Be sure to save the changes and Right click on “index.jsp” in the IDE (OEPE) 
“Project Explorer” view window and select “Team | Commit”. Update the “Commit 
message” as desired or go with the default. Once ready, select the “Commit and 
Push” button. 

 

30. The results of the “Commit and Push” operation will be provided in a dialogue 
once complete. Select the “OK” button to exit. 

 

  



31. The task should still be open so select the “Update index.jsp” tab in the IDE 
(OEPE). If it’s not open, right click on the task in “Task List” in the IDE (OEPE) 
and select open. Update the task with a “New Comment” and an action of 
“Resolve as” and select “Fixed” from the list-of-values. Select the “Submit” button 
to update the task. 

 

32. The issue is now flagged as complete. 

 

33. Now go back to the ODevCS Web Dashboard browser and select the 
“Dashboard” tab to see the most recent activity. Follow the steps provided earlier 
in this lab to perform a diff on “index.jsp” to see the changes you’ve made as 
desired. 

  



Step 4: Create a code review within the browser (ODevCS Web Dashboard).  

1. Create a code review within ODevCS Web Dashboard browser. Select the 
“Merge Requests” tab. In the “Merge Requests” tab select the “New Request” 
button. 

 

2. Enter the following details or similar in the Code Review form and select the 
“Create” button. 

Submitter by default will be the creator of the code review 

Repository: oow-contacts-soap-service.git 

Review Branch: crudbranch 

Target Branch: master 

Summary: Code Review of new web methods and index.jsp 

Reviewers: Add yourself. Note: You would generally add other team members. 

Description: Add some descriptive text 

 



3. Team members that have been added to this code review would now receive 
messaging (email) that they’ve been asked to collaborate on a code review in the 
project. They can Approve or Reject the code review and provide descriptive text 
to support their decision. Browse the code changes if desired by going to the 
objects modified. At this point, go ahead and “Approve” the code review by 
selecting the “Approve” button and provide an appropriate description of the 
approval. Select the “OK” button. 

 

4. Select the “Merge Requests” tab to review the status of the Code Review. 

 

5. Select the Code Review to open it and Merge the code from the “work” branch 
into the “master”.  

 

  



6. Provide a comment for the Merge as desired followed by selecting the “OK” 
button. 

 

7. Navigate back to the “Home” tab within the ODevCS Web Dashboard browser 
and see the recent activity which includes the Code Review and Merge. 

 



Step 5: Build the OOW Contacts SOAP Service project. 

1. To build the OOW Contacts SOAP Service project go to the “Build” tab on the 
ODevCS Web Dashboard browser. Notice that a build may have already started. 
This is due to the build job configuration whereby a build will occur every time 
code is merged into the “master” branch. A manual build may also be invoked by 
selecting the “Build Now” icon  as indicated in the image below.  

 

2. Hudson build job was pre-configured in the application pom.xml. The OOW 
Contacts SOAP Service project was successfully built as indicated by the green 
icon in the first row of the table. This build was invoked automatically shortly after 
pushing the contacts application to the ODevCS Git repository. 

 

 

3. Select the “contacts-build” job in the table from the “Build” tab to view the history 
of the builds for the project and to see the results of the most recent build. 

 

  



4. Select the “Console” icon in the “Build History” table to view the console log of 
the build process. Further configuration of the build process is available as well 
as invocation of another build as desired. 

 

  



Step 6: Deploy the OOW Contacts SOAP Service project to the Oracle Java Cloud 
Service (OJCS - SX) SaaS extension. 

1. In order to deploy the OOW Contacts SOAP Service project that was just built, 
select the “Deploy” tab in the ODevCS Web Dashboard browser. 

 
2. Select the “New Configuration” button to create a new deployment configuration 

and provide the following configuration details. 

Configuration Name: contacts 

Application Name: contacts 

Java Service: jcs1 

Type: On Demand 

Job: contacts-build 

Build: Select the most recent successful build. 

Artifact: contacts/target/contacts.war 

Once the “New Deployment Configuration” is completed, select the “Save and 
Deploy” button. 

 

  



3. After selecting the “Save and Deploy” button, the project will be saved and 
deployed to OJCS-SX and viewing of the status of the configuration creation and 
deployment is available. 

 

4. Select the “Java Service” link “oracletemplates/jcs1”.  

 

5. Sign in to OJCS-SX using the credentials provided by the lab instructor if 
prompted to log in. 

 

  



6. Once authenticated, the OJCS-SX Control is launched in the browser. Explore 
the various panel boxes within the OJCS-SX Control dashboard. 

 

7. Select the contacts application in the “Applications” panel box on the top right of 
the OJCS-SX Control Dashboard. 

 

  



8. Select the “Application URL” link to launch and test the jsp page that is part of the 
OOW Contacts SOAP Service project. 

 

9. The test jsp page is now visible for the project that has been successfully built 
and deployed from ODevCS to OJCS-SX. 

 

Summary 
In this tutorial you created an ODevCS project from template. You learned how to: 

• Work with ODevCS and the various features provided within the dashboard 
• Connect to your ODevCS instance from within your IDE (OEPE) 
• Clone a project from ODevCS and import it into your IDE (OEPE) 
• Created tasks within ODevCS and resolve those tasks within your IDE (OEPE) 

by creating a branch and working within that branch 
• Commit / push your contacts project code updates to the Git repository within 

ODevCS 
• Createa Code Review and Merg your working branch into the master branch 
• Build your project with Hudson Continuous Integration in ODevCS 
• Deploy your contacts application to OJCS-SX 

To learn more about using ODevCS, refer to the product page: 

• https://cloud.oracle.com/developer_service 

 


